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Important Information

Warranty

The SC-2345/2350 carrier is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective
during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire,
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section
on ni.com/legal for more information about National Instruments trademarks.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no
agency, partnership, or joint-venture relationship with National Instruments.

Patents

For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents. txt file
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL



INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

»

> &

bold

italic

monospace

monospace italic

The following conventions are used in this manual:

Angle brackets that contain numbers separated by an ellipsis represent
arange of values associated with a bit or signal name—for example,
AO <3..0>.

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked

on the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document shipped with the product for precautions to take.

When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.
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Setting up the SC-2345/2350

Carrier

This document assumes you have already installed, configured, and tested
the SC carrier, SCC modules, and the DAQ device to which they are
connected. If you have not done so, follow the instructions in the DAQ
Getting Started Guide and SCC Quick Start Guide, included with the
hardware, before continuing. The SCC Quick Start Guide and DAQ Getting
Started Guide are also available at ni . com/manuals or accessible from
Start»Programs»National Instruments»NI-DAQ»Browse Device
Documentation after you install the DAQ documentation browser.

About the SCC Hardware

SC-2345 Carrier

The SC-2345/2350 carrier transfers signals to and from 68-pin E/M Series
data acquisition (DAQ) devices, referred to as the DAQ device in this
manual. When used with SCC Series modules and a shielded 68-pin cable,
the SC-2345/2350 carrier offers easy-to-use, rugged, low-noise signal
conditioning on a per-channel basis. The SC-2345/2350 carrier also has
42 screw terminals for direct connection to the DAQ device digital signals.

Some SC-2345 carrier enclosures are available with configurable
connectors to maximize I/O flexibility through the use of panelettes.

All SC-2345/2350 carriers are portable enclosures for laptop and desktop
applications.

Optional rack-mount and stack-mount accessories enable you to mount
the SC-2345/2350 carrier with configurable connectors to suit your
application. The rack-mount option is available for standard 19 in. racks.

The SC-2345 carrier supports analog I/O and digital I/O SCC modules. The
SC-2345 is available in the following forms:

*  SC-2345 connector block—the SC-2345 connector block requires you
to pass input signal wires through a strain relief
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Chapter 1 Setting up the SC-2345/2350 Carrier

e SC-2345 carrier with configurable connectors and a rear cable
connector

e SC-2345 carrier with configurable connectors and a side cable
connector

@ Note Refer to Figure 1-9 and the SCC Quick Start Guide for more information about all

these carrier forms.

SC-2350 Carrier

The SC-2350 carrier supports analog I/O SCC modules. The SC-2350
carrier supports reading from and writing to Transducer Electronic Data
Sheet (TEDS) Class II sensors for its analog input SCC modules. The
SC-2350 carrier is available with configurable connectors and a side cable
connector. Refer to Figure 1-9 and the SCC Quick Start Guide for more
information.

What You Need to Get Started

To set up and use the SC-2345/2350 carrier, you need the following items:

U Hardware

or

SC-2345/2350 carrier with one of the following factory-installed
power modules:

*  SCC-PWRO1
¢ SCC-PWRO02 and the PSO1 power supply

e SCC-PWRO3 (requires a 7 to 42 VDC power supply,
not included)

68-pin E/M Series DAQ device with a shielded 68-pin cable of
less than 2 m length

100-pin E Series DAQ device with an SH1006868 cable
(to connect 100-pin devices to two 68-pin connectors)

One or more SCC modules
Rack-mount or stack-mount kit (optional)

One or more I/O panelettes

@ Note You cannot use the I/O panelettes on the SC-2345 carrier with connector block.

SC-2345/2350 Carrier User Manual
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Chapter 1 Setting up the SC-2345/2350 Carrier

U Software
— NI-DAQ 7.4 or later for Windows 2000/NT/XP

@ Note Software scaling of measurements is not supported on the Macintosh operating
system.

U Documentation
—  SCC Quick Start Guide
—  100-pin or 68-pin E/M Series DAQ device documentation
—  DAQ Getting Started Guide
—  Read Me First: Safety and Radio-Frequency Interference
—  SC-2345 carrier Quick Reference Label, if you have an SC-2345
carrier
U Tools
— 1/8 in. flathead screwdriver
—  Numbers 1 and 2 Phillips screwdrivers

—  Wire insulation strippers

Installing the Driver Software

Install your application development environment (ADE) software and/or
NI application software, if you have not already done so, according to their
instructions.

Install NI-DAQ, which came with the DAQ device, if you have not already
done so. If you do not have version NI-DAQ 7.4 or later, you can either
download it from the National Instruments Web site at ni . com/
downloads or contact a sales representative to request a CD.

Follow the software prompts to install NI-DAQ. If you do not see the Install
NI-DAQ screen when you insert the CD, go to the Windows Start»Run.
Type x: \setup.exe (xis the letter of your CD drive). The NI-DAQ
installer detects the language of your operating system and the screens
appear in that language.
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Chapter 1 Setting up the SC-2345/2350 Carrier

Connecting the SC-2345/2350 Carrier to the DAQ Device

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting or disconnecting any signal wires.

Use a 68-pin shielded cable to connect the SC-2345/2350 carrier to the
E/M Series DAQ device. Use connector J24 on the SC-2345/2350 carrier.
The pin assignment of J24 is defined by the DAQ device MIO front
connector. Refer to Figure 1-9 for the location of connector J24.

The chassis ground terminal on the SC-2345 carrier and the
electromagnetic interference (EMI) gasket attached to the strain
relief of the SC-2345 carrier are for grounding a floating source

(1 mA maximum). Do not use these terminals as safety earth grounds.

Configuring the SC-2345 Carrier as a DAQ Accessory

Complete the following steps to run Measurement & Automation Explorer
(MAX) and configure the SCC system:

1. Open MAX.
2. Right-click Devices and Interfaces and select Create New.

3.  Under NI-DAQmx SCC Connector Block, select SC-2345. Click
Finish.

4. In the SCC Connector Block Configuration window, configure the
SCC system as follows.
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SCC Connector Block Configuration

Elack Carrier, Side Connector I=| [|PCI-e024E: "Deve" - SCCS

SCC-PYWR0Z

r

DHE
one
DHE!
one
DHE!
one
DHE!

N
N
N

None

Figure 1-1. SCC Connector Block Configuration Window

a. Specify the SCC Carrier Type. The location of the SCC sockets
changes depending on the SCC carrier type.

b. In the drop-down listbox under DAQ Device, select the
E/M Series DAQ device that is connected to the SC-2345 carrier.

Type the SCC Connector Block ID. The default value is scc1.

d. In the J21 drop-down listbox next to Power, select the correct
SC-2345 power configuration. Refer to Connecting Power to the
SC-2345/2350 Carrier section for information about power
configurations.
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e. For each SCC module physically installed in the SC-2345 carrier,
add a corresponding entry in the SC-2345 Connector Block
Configuration window. Click the drop-down listbox and select the
correct module. If the module name does not appear in the list,
either the module is not allowed in that location or you do not have
NI-DAQ 7.4 or later. If you do not have the current version of
NI-DAQ, download it from ni . com/downloads.

5. Click OK after completing all SCC module entries.
6. Click OK to complete the configuration process and close MAX.

You have completed the steps to configure the SC-2345 carrier as an
E/M Series DAQ device accessory.

@ Note Configuring the SCC system using MAX automatically sets the E/M Series DAQ
device analog input mode to NRSE. If you are configuring digital SCC modules, the
configuration automatically sets individual digital lines to the appropriate direction, input
or output.

Configuring the SC-2350 Carrier as a DAQ Accessory

Complete the following steps to run MAX and configure the SCC system:
1. Open MAX.

2. Right-click Devices and Interfaces and select Create New.

3.  Under NI-DAQmx SCC Connector Block, select SC-2350.
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Create New...

Measurement & w

Automation Explorer

= Devices and Inteffaces ~
=Bl MI-DAQms Device
B RTSI Cable
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-l RDA/Ethemet Device
@ 501000 =
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@ 50001 |

Bock |tz | [ Fnsh | Cancel |

Figure 1-2. MAX Window with the SC-2350 Carrier Selected

4. Click Finish. The SC-2350 Configuration window opens.
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5. To configure the SCC system, complete the following steps:

SC-2350 Confipuration

| 5C-2350 Configuration
DA Device SCC Connector Block 1D
[PCI-6052E; "Devl” v | [scca |
31 |Mone = ]
32 |Mone v Z P
T [}
73 [Mone ¥ = @
2 ffne Vi @
[ w o
15 |SCC-a10 v = . g
i %]
(B
e e o C
38 |5CC-ALD w| 2 > s
L [}
17 [sCc-at0 v = @ %
o s
&
18 |5CC-a10 v| 2 @ =
-------- — = TN
'_
17 !None w | o .
i
= = <
11& Mone ¥ = .
Pawser TEDS Faund
371 |SCC-PWROZ v |
Scan for TEDS ] [ Help ] [ (o] 4 ] [ Cancel

Figure 1-3. SC-2350 Configuration Window

a. In the drop-down listbox located under DAQ Device, select the
E/M Series DAQ device that is connected to the SC-2350 carrier.

b. Type the SCC Connector Block ID. The default value is scC1.

c. Inthe J21 drop-down listbox next to Power, select the correct
SC-2350 carrier power configuration. Refer to the Connecting
Power to the SC-2345/2350 Carrier section for information about
power configurations.
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d. For each SCC module physically installed in the SC-2350 carrier,
add a corresponding entry in the SC-2350 Configuration window.
Click the drop-down listbox and select the correct module. If the
module name does not appear in the list, either the module is not
allowed in that location or you do not have NI-DAQ 7.4 or later. If
you do not have the current version of NI-DAQ, download it from
ni.com/downloads.

e. MAX automatically scans the SCC modules you select for IEEE
P1451.4 sensors that are compatible with TEDS. If MAX finds a
TEDS, MAX scans and maps a TEDS icon and information under
the SCC module in MAX. For more information, refer to the
TEDS section.

6. Click OK after completing all SCC module entries.
7. Click OK to complete the configuration process and close MAX.

You have completed the steps to configure the SC-2350 carrier as an
E/M Series DAQ device accessory.

@ Note Configuring the SCC system using MAX automatically sets the E/M Series DAQ
device analog input mode to NRSE.

TEDS

This section describes TEDS.

IEEE P1451.4 specifies two classes of TEDS sensors:

*  Class I—Uses the same two wires for both analog and digital signals
(such as accelerometers and microphones).

*  Class II—Separates analog and digital signals on different wires. In
addition to the analog signal wires, uses two wires for digital signals.
The SC-2350 carrier uses Class II TEDS.

On IEEE P1451.4 TEDS-compatible sensors, the manufacturer places

an EEPROM on the sensor that stores a TEDS. The TEDS includes vendor
and calibration information, sensor constants, and user-defined data.
TEDS-compatible hardware, like the SC-2350 carrier, can read the TEDS
data. Software can use TEDS data to streamline measurement setup.

Advantages and disadvantages to using TEDS-compatible sensors include
the following:

e Smart, or hardware, TEDS—Provides easier connectivity. You can
plug it in and automatically set up your measurement system.
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e Virtual, or software, TEDS (also part of the IEEE P1451.4
specification)—Obtains sensor information from a vendor Web site,
instead of an EEPROM. The information is free and does not require a
hardware upgrade. However, you must manually select the correct
channel and sensor.

The following resources provide additional information about
IEEE P1451.4 TEDS-compatible smart sensors:

e SCXI-1314T TEDS Bridge Sensor Terminal Block Installation Guide
* Refertoni.com/info, and enter any of the following info codes:

— rd2350
- rdsenr
- rdpnpy
- rdpnsn
— rdtntg

. ni.com/devzone

For information about how to configure channels and tasks with the
SC-2350 carrier, refer to the SCC Quick Start Guide.

Importing TEDS Information

To import smart hardware TEDS sensor information into MAX, first install
and configure the SCC modules. Refer to the SCC Quick Start Guide for
more information about how to install and configure the SCC modules.

If your system has smart hardware TEDS, MAX automatically scans and
maps the TEDS sensor information into MAX. If MAX finds a TEDS
associated with the SCC module, the LED lights up as shown in Figure 1-4.

If you later add SCC modules to your system that have TEDS-compatible
sensors physically wired to them, click Scan for TEDS to import the TEDS
sensor information into MAX and refresh the configuration tree.
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Setting up the SC-2345/2350 Carrier

As shown in Figure 1-4, MAX scans and maps the TEDS information
under the SC-2350 carrier.
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Figure 1-4. TEDS Sensor Information Scanned and Mapped Into MAX

SC-2345/2350 Carrier User Manual



Chapter 1 Setting up the SC-2345/2350 Carrier

To view the TEDS sensor data sheet, click the TEDS listing under the
SC-2350 in MAX. The TEDS sensor data sheet opens as shown in

Figure 1-5.
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Figure 1-5. TEDS Sensor Data Sheet

Verify that the TEDS data is correctly imported. Next, create an
NI-DAQmx Global Channel or Task using the channel that has a TEDS
sensor associated to it. Refer toni . com/info and enter rd2350, for more
information about how to create an NI-DAQmx Global Channel or Task for
a TEDS sensor.

Importing Virtual TEDS Sensor Information

To import Virtual TEDS sensor information into MAX, first install and
configure the SCC modules. Refer to the SCC Quick Start Guide, for more
information about how to install and configure the SCC modules.
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Chapter 1 Setting up the SC-2345/2350 Carrier

To import Virtual TEDS sensor information into MAX, right-click the SCC
module that you want a Virtual TEDS sensor associated to and select
Configure TEDS.

Test Parnels. .,

Renare

2 Delete

=== Configure TEDS. ..

m Device Pinouts, .,

The Configure TEDS window opens as shown in Figure 1-6.

Configure TEDS X
“hannels TEDS InfFormation ~
= SCCIModS (SCC-A10

ail Mo sensor configured

m AL Temperature:RTD Scan For Hww TEDS
Impart Yirkual TEDS
Remoave TEDS

€

|1#
|

[ Ok, ” Cancel H Help

Figure 1-6. Configure TEDS Window

1. Click Import Virtual TEDS.
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Chapter 1 Setting up the SC-2345/2350 Carrier

2.

The virtual TEDS directory opens as shown in Figure 1-7.
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Files of type: * ted [* ted) | Cancel
Figure 1-7. Virtual TEDS Directory
3. Press <Ctrl> and select the virtual TEDS file you want to import into
MAX to associate with the SCC module.
4. Click OK.
MAX scans and maps the TEDS sensor information into MAX. The
LED turns green.
5. To verify that the TEDS sensor information imported correctly, click
the TEDS sensor icon in the configuration tree. The TEDS sensor data
sheet opens as shown in Figure 1-5.
6. Next, you need to create an NI-DAQmzx Global Channel or Task
using the channel that has a TEDS sensor associated to it.
@ Note Refertoni.com/info andenter rd2350, for more information about how to create

a NI-DAQmx Global Channel or Task for a TEDS sensor.

You

SC-2345/2350 Carrier User Manual

have configured the SC-2350 carrier in MAX.
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Chapter 1 Setting up the SC-2345/2350 Carrier

Affixing the Quick Reference Label to the SC-2345
Carrier

@ Note Only the SC-2345 carrier is shipped with a Quick Reference Label.

Affix the Quick Reference Label to the inside cover of the SC-2345 carrier.
You will refer to the Quick Reference Label when installing the SCC
modules.

Connecting Power to the SC-2345/2350 Carrier

The SC-2345/2350 shielded carrier has one of the following power
modules factory-installed in socket J21:

* SCC-PWROI
*  SCC-PWRO02
* SCC-PWRO03

R0 ]

1 Negative or GND of External Supply 4 S
2 J1 5 Product Name
3 Positive of External +5 VDC Supply

Figure 1-8. SCC-PWROX Parts Locator Diagram

Each power module supplies digital power (+5 V) for the SC-2345/2350
carrier only and analog power (15 V) to SCC modules in the
SC-2345/2350 carrier. LEDs on the SC-2345/2350 indicate whether the
+5 V and +15 V power supplies are functioning properly. If the LEDs do
not light when you connect power to the SC-2345/2350 carrier, refer to
Appendix C, SCC Power Requirements and Solutions. Figure 1-9 shows
the locations of sockets J24 and J25 on each of the three types of SC-2345
carrier enclosures and the SC-2350 carrier enclosure.
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Chapter 1 Setting up the SC-2345/2350 Carrier

1 SC-2345 Carrier 5 Connector J24 (Connects to 68-Pin
2 SC-2345 Carrier with Configurable E/M Series DAQ Device)

Connectors, Side Cabled 6 Connector J25 (Connects to PS01 Power Supply
3 SC-2350 Carrier with Configurable for Use with SCC-PWRO02 Power Module)

Connectors, Side Cabled

4 SC-2345 Carrier with Configurable
Connectors,
Rear Cabled

Figure 1-9. SC-2345/2350 Enclosures
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Chapter 1 Setting up the SC-2345/2350 Carrier

SCC-PWRO1

The SCC-PWROI converts +5 V to £15 V, which is the analog power
supply that SCC modules use. Set switch S1 on the SCC-PWRO1 to select
the source of the +5 V as either E SER (E/M Series) or EXT (external). If
you select E SER, the SCC-PWRO1 uses +5 V power from the E/M Series
DAQ device. If you select EXT, you must connect a +5 V supply (user
supplied) to the screw terminals of J1 on the SCC-PWRO1. Wire the
positive lead to the screw terminal labeled +5 V and wire the negative lead
to the screw terminal labeled GND. If you are using the SC-2345 carrier,
pass the leads through the strain relief on the front of the enclosure. If you
are using an SC-2345/2350 with configurable connectors, use a strain-relief
panelette for the leads.

1 SC-2345/2350 Carrier 5 Positive Lead to +5 V Screw Terminal
2 5VDC Power Supply (User-Supplied, Optional) on SCC-PWRO01 Connector J1

3 DAQ Device 6 Negative Lead to GND Screw Terminal
4 J24 on SCC-PWRO01 Connector J1

Figure 1-10. Using the SCC-PWRO01
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Chapter 1 Setting up the SC-2345/2350 Carrier

SCC-PWR02

The SCC-PWRO02 is a two-part system that consists of a desktop power
supply (PS01) and a filtering component (SCC-PWRO02 inside the carrier
enclosure). The PSO1 is a 15 W switching supply powered by 90 to

264 VAC (50/60 Hz 1.0 A). To install the PSO1, plug the 6-position
connector of the PSO1 into connector J25 on the SC-2345/2350.

1 SC-2345/2350 Carrier 4 To Connector J24
2 PS01 Power Supply 5 To Connector J25
3 DAQ Device

Figure 1-11. Using the SCC-PWR02
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Chapter 1 Setting up the SC-2345/2350 Carrier

SCC-PWR03

The SCC-PWRO3 converts an external voltage of 7 to 42 VDC to +5 V and
+15 V and requires an external user-supplied DC power source. Attach the
voltage source to the screw terminals of J1 on the SCC*-PWRO03. Wire the
positive lead to the screw terminal labeled 7—42 V and wire the negative
lead to the screw terminal labeled GND. If you are using the SC-2345
carrier, pass the leads through the strain relief on the front of the enclosure.
If you are using an SC-2345/2350 carrier with configurable connectors, use
a strain-relief panelette for the leads. You can power the SCC-PWRO03 with
any appropriate 7 to 42 VDC source.

1 SC-2345/2350 Carrier 5 Negative Lead to GND Screw Terminal
2 7-42 VDC Source (User-Supplied) on SCC-PWRO03 Connector J1

3 DAQ Device 6 Positive Lead to +5 V Screw Terminal
4 To Connector J24 on SCC-PWRO03 Connector J1

Figure 1-12. Using the SCC-PWR03

Installing SCC Modules in the SC-2345/2350 Carrier

For instructions about how to install SCC modules in the SC-2345/2350
carrier and information about signal conditioning with SCC modules, refer
to the SCC Quick Start Guide.
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Connecting Signals to the
Terminal Block of the
SC-2345/2350 Carrier

The SC-2345/2350 carrier has a 42-position, triple-row screw-terminal
block for connecting to E/M Series DAQ device digital signals. The
SC-2345 Quick Reference Label identifies the location of each signal on
the terminal rows A to C. The terminal label numbers correspond to the pin
number location of each signal on the 68-pin E/M Series connector. Refer
to the E Series Help or M Series Help for more information about this
connector. The E Series Help and the M Series Help are available for
download at ni . com/manuals or accessible from Start»Programs»
National Instruments»NI-DAQ»Browse Device Documentation after
you install the DAQ documentation browser.

Figure 2-1 shows the locations of the digital signals on the SC-2345 and
SC-2350 terminal block when using an E Series or M Series connector 0.
Refer to the M Series Help, for specific pinout descriptions for M Series
devices when using connector 1.
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Chapter 2 Connecting Signals to the Terminal Block of the SC-2345/2350 Carrier

A B c

Not Used ] Not Used ] Not Used ]

Not Used | | DGND |[35] AI SENSE | 62]

PFI 14/FREQOUT | 1 | DGND | 4 | PFI 10/EXTSTROBE* | 45 |
PFI12/CTROOUT | 2 | DGND |36 PFI 13/CTR 1 OUT |40
PFI 8/CTR 0 SOURCE | 37 | DGND |[39] PFI9/CTR 0 GATE | 3 |
PFI 6/AO STARTTRIG | 5 | DGND | 7 | PFI 7/Al SAMP CLK | 38 |
PFI 4/CTR 1 GATE | 41| DGND | 9 | PFI 5/A0 SAMPLE CLK | 6 |
PFI 2/Al CONV CLK | 43| DGND |44 PFI3/CTR 1 SOURCE |42
PFI 0/AI START TRIG | 11| DGND [12] PFI 1/Al REFTRIG |10
+5V [14] DGND |[13] PFI 11/Al HOLD COMP | 46 |

P0.6 |16 DGND [15] P0.7 |48]

P04 [19] DGND |50 P05 |51]

P0.2 [49] DGND |[18] P0.3 |47]

P0.0 |52] DGND |53 Po.1 [17]

Figure 2-1. Terminal Block 1/0 Connector Pin Assignments E Series
and M Series Connector 0

Rack-Mounting and Stack-Mounting Options

To use the SC-2345/2350 carrier with configurable connectors in a
standard 19 in. rack-mount configuration, install the optional CA-1000
rack-mount kit. To use the SC-2345/2350 carrier with configurable
connectors in a desktop stacking configuration, install the optional
CA-1000 stack-mount kit.

Installing the Rack-Mount Kit

Refer to Figure 2-2 and complete the following steps to install the CA-1000
rack-mount kit on the SC-2345/2350 carrier with configurable connectors:

1. Remove the rubber feet from the bottom of the SC-2345/2350 carrier
enclosure.

2. Attach a rack-mount bracket to both ends of the enclosure with
four 4-40 X 1/4 in. screws from the rack-mount Kkit.
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Chapter 2 Connecting Signals to the Terminal Block of the SC-2345/2350 Carrier

‘ 1 4-40X 1/4in. Screws 2 Rack-Mount Brackets |

Figure 2-2. Rack-Mount Option

Installing the Stack-Mount Kit

Refer to Figure 2-3 and complete the following steps to install the CA-1000
stack-mount kit on the SC-2345/2350 carrier with configurable connectors:

1. Remove the rubber feet from all except the bottom enclosure.

2. Attach the stack-mount brackets to both ends of the lower
enclosure with the 4-40 x 1/4 in. flathead screws from the
stack-mount Kkit.

Place the upper enclosure on top of the lower enclosure.

4. Attach the stack-mount brackets to both ends of both enclosures with
the 4-40 x 1/4 in. flathead screws from the stack-mount Kkit.
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Chapter 2 Connecting Signals to the Terminal Block of the SC-2345/2350 Carrier

1 4-40 X 1/4 in. Screws 2 Stack-Mount Brackets 3 Handle Screws

Figure 2-3. Stack-Mount Option
You can stack additional enclosures by using additional stack-mount kits.

You can remove the stack-mount kit handles, if necessary, by removing the
four screws that attach the handles.
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Specifications

These ratings are typical at 25 °C unless otherwise stated.

SC-2345 Carrier

Analog Input and Output

I/O connections ........cccceeveeueeveneecuennennee Sixteen, 20-pin connectors for
analog-input SCC modules
(eight are shared with digital);
two 20-pin connectors for
analog-output SCC modules

Digital Input and Output

I/O connections ........coceeeveeeeveneenienennnes Eight, 20-pin connectors for
digital (shared with analog input)
42-position, triple-row terminal
block for digital and counter

Onboard Voltage Reference

Output voltage.......ccccevecrevueecieneeieeneenne. 5.000 V £2.5 mV
Output voltage drift........cccoveeeienineeene 5 ppm/°C max (at 0 to 70 °C)
Long-term stability.........ccccceceenerveenennen. +15 ppm/1,000 h
Output noise (0.1 to 10 Hz)........coueenee. 4uV,,
Load regulation
Sourcing 0 < Ipyr< 10 mA............. 100 uV/mA
Sinking —10 < Ipyr < O mA............. 400 uV/mA
Quiescent CUrrent ..........cceeeeevveeeenveeennnenn. 2 mA
Power consumption...........coeceeevveeneennnen. 30mW, 15V
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Appendix A Specifications

LED Power Requirements

6.5MAAtSV i, 32.5 mW
OMA At 15V i 135 mW
OMA at =15V i 135 mW

Maximum Working Voltage

A Cautions Refer to your DAQ device documentation for the voltage specifications for your
DAQ device.

Ensure that signals connected to SCC modules are used within the voltage ratings of the
modules to which they are connected. Refer to your SCC-XX user manual for the voltage

specifications for your SCC module.

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth .........cccccovvvvvvveeeeeeennennn. 11 VDC

Measurement Category I

Caution Do not use the SCC-2345 for connections to signals or for measurements within
Categories II, 111, or IV.

Physical

Field-wiring diameter
(terminal block) ........ccoeveiieiiiiiiiiei, 26to 16 AWG

SC-2345/2350 Carrier User Manual A-2 ni.com



Appendix A Specifications

SC-2345 Connector Block

24.77 cm
(9.751in.)

«—» - >
4.4 cm 26.2 cm
(1.731in.) (10.31in.)

Figure A-1. SC-2345 Connector Block Dimensions
Weight ..o 1.66 kg (3 1b 10 0z)

T/O CONNECLOTS c.evvveveeeeeeeeeeeeeeeeeeeeeeeeeee One 68-pin male SCSI connector;
one 6-pin male power connector
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Appendix A Specifications

SC-2345 with Configurable Connectors

(Rear and Side Cabled)
S
[
25.4 cm
(10.00 in.)
[ i
i Y
Caoem 30.75 cm '
(1.93in.) (12.11in.)

Figure A-2. SC-2345 With Configurable Connectors Dimensions
WEeight .o, 1.51 kg (31b5 0z)

1/O cONNECLOrS...ccvvviieiiiiiieieieeieiiiiiieene User-defined panelettes;
one 68-pin male SCSI connector;
one 6-pin male power connector
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Appendix A Specifications

Environmental
Operating temperature............coceeeeeeueenee. 0to50°C
Storage temperature ............ccceeeeeevenneee —20to 70 °C
Humidity «..oooovevveveeiciiicieinencnceeene 10 to 90% RH, noncondensing
Maximum altitude ...........ooovvveveveiinennnns 2,000 m
Pollution Degree (indoor use only)........ 2

Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« JEC61010-1, EN-61010-1
« UL 61010-1, CSA 61010-1

@ Note For UL and other safety certifications, refer to the product label or visit ni.com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Electromagnetic Compatibility

This product is designed to meet the requirements of the following
standards of EMC for electrical equipment for measurement, control,
and laboratory use:

* EN 61326 EMC requirements; Minimum Immunity
 EN 55011 Emissions; Group 1, Class A
* CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

@ Note For EMC compliance, operate this device according to product documentation.
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Appendix A

Specifications

CE Compliance

5

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

*  2006/95/EC; Low-Voltage Directive (safety)
e 2004/108/EEC; Electromagnetic Compatibility Directive (EMC)

Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit ni . com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Environmental Management

P

National Instruments is committed to designing and manufacturing
products in an environmentally responsible manner. NI recognizes that
eliminating certain hazardous substances from our products is beneficial
not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the
Environment Web page at ni.com/environment. This page contains the
environmental regulations and directives with which NI complies, as well
as any other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)

EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling
center. For more information about WEEE recycling centers and National Instruments
WEEE initiatives, visit ni.com/environment /weee.htm.

BFEErmSRIEFEEMZE (PE ROHS
HREZEA  National Instruments 744 m E H 45 5™ 5 b BRI 284 S 4 54 4 (RoHS).

KT National Instruments ' RoHS & #iME(E &, %K ni. com/environment /rohs_china.
(For information about China RoHS compliance, go to ni . com/environment/rohs_china.)
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Appendix A Specifications

SC-2350

Analog Input and Output

I/O connections ........c.ceeeveeeeeveneeneennennnen Eight, 20-pin connectors and
eight 2-channel TEDS screw
terminal blocks for analog-input
SCC modules;
two, 20-pin connectors for analog
output SCC modules

Typical maximum smart TEDS

sensor cable length.......c..cceceeviinnenncen. 61 m (200 ft)
IEEE P1451.4 compliance ..................... Tier 2 (standard system
capability)

@ Note Future releases of NI-DAQmx might contain support for TEDS analog ouput
devices.

Onboard Voltage Reference

Output voltage.......ccevveveneenienienieeeene 5.000 V £2.5 mV

Output voltage drift......cccccevveeerienvrennnenne 5 ppm/°C max (at 0 to 70 °C)
Long-term stability.........cccccoceevirienene. +15 ppm/1,000 h

Output noise (0.1 to 10 Hz).................... 4uV,,

Load regulation

Sourcing 0 < Ipyr < 10 mA............. 100 WV/mA

Sinking —10 < Ipyr < 0 mA............. 400 uV/mA
Quiescent CUITent ............eceeeeuvveeeeeeennneen. 2 mA
Power consumption...........cceceeeeneenueenee. 30 mW

LED Power Requirements

6.5MA AS Vi 32.5 mW
OMA At IS5 Vi 135 mW
OMA at =15 Vi 135 mW
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Appendix A Specifications

Maximum Working Voltage

A Cautions Refer to your DAQ device documentation for the voltage specifications for your
DAQ device.

Ensure that signals connected to SCC modules are used within the voltage ratings of the

modules to which they are connected. Refer to your SCC-XX user manual for the voltage
specifications for your SCC module.

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth .............coovveereeeiinnnnennn. 11 VDC

Measurement Category 1

A Caution Do not use the SCC-2350 for connections to signals or for measurements within
Categories II, I11, or I'V.
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Appendix A Specifications

Physical
Field-wiring diameter
(terminal block)......ccoooevvvieeciiiieiieeeiie, 26to 16 AWG
SC-2350 with Configurable Connectors
(Side Cabled)
-ge
i
25.4cm
(10.00 in.)
: 1
. 2
-« > - >
4.9cm 30.9cm
(1.93in.) (12.17in.)
Figure A-3. SC-2350 Dimensions
WeEIght . c.eiiieiiiieienieeecccee 1.60 kg (3 1b 8.8 0z)
I/O connectors...........coceeeveeeeieneececnneenne. User-defined panelettes;

one 68-pin male SCSI connector;
one 6-pin male power connector;
one 50-pin male test header
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Appendix A Specifications

Environmental
Operating temperature ..........cc.cceceevverneene 0to 50 °C
Storage temperature..............cceeeeecuennnes —20to 70 °C
Humidity ....occooevineneniiciicieicccceeee 10 to 90% RH, noncondensing
Maximum altitude...........oooovvvvveieiinnnnnns 2,000 m
Pollution Degree (indoor use only) ........ 2

Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« JEC61010-1, EN-61010-1
e UL 61010-1, CSA 61010-1

@ Note For UL and other safety certifications, refer to the product label or visit ni.com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Electromagnetic Compatibility

This product is designed to meet the requirements of the following
standards of EMC for electrical equipment for measurement, control,
and laboratory use:

e EN 61326 EMC requirements; Minimum Immunity
e EN 55011 Emissions; Group 1, Class A
e CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

@ Note For EMC compliance, operate this device according to product documentation.
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Appendix A Specifications

CE Compliance

5

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

*  2006/95/EC; Low-Voltage Directive (safety)
*  2004/108/EEC; Electromagnetic Compatibility Directive (EMC)

Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit ni . com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Environmental Management

154

National Instruments is committed to designing and manufacturing
products in an environmentally responsible manner. NI recognizes that
eliminating certain hazardous substances from our products is beneficial
not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the
Environment Web page at ni . com/environment. This page contains the
environmental regulations and directives with which NI complies, as well
as any other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)

EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling
center. For more information about WEEE recycling centers and National Instruments
WEEE initiatives, visit ni.com/environment /weee.htm.

BT EEEmsHEEFEEME (FE ROHS)

FEZEA National Instruments 74 m E L3 5™ 5 P R B A 24 H 0 5t 4 (ROHS).
T National Instruments H' [ RoHS & #ITEE R, %% ni. com/environment /rohs_china.
(For information about China RoHS compliance, go fo ni . com/environment/rohs_china.)
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Appendix A

Specifications

SCC Power Modules

SCC-PWRO01

Input
DC input voltage

DC input power

Output

From external power source............. +5 VDC +5%
From E/M Series DAQ device ........ +5 VDC £5%

500 mW without SCC modules

Maximum Power OQutput by Voltage Level

+5VDC +15 VDC -15VvDC
(+4.17 to (+14.20 to (-14.20 to
Voltage Source +5.25 VDC) +15.25 VDC) -15.25 VDCO)
AT/PCI/PXI E/M Series 4.18 W* 0.87 W 0.87 W
DAQ Device!
DAQCard/DAQPad 0.80 W* 0.24 W 024 W
E Series DAQ Device?
External +5 VDC Supply 6.97 W* 0.87 W 0.87W

! These power calculations apply to E/M Series DAQ devices that provide +5 VDC at 1 A at the I/O connector. Refer to the
specifications for the E/M Series DAQ device. Tests were performed using a 1 m cable. Longer cables yield a lower level of

power, but the difference is negligible for cables of 2 m or less in length.

2 These power calculations apply to E Series DAQ devices that provide +5 VDC at 250 mA at the I/O connector. Refer to the
specifications for the E Series DAQ device. Tests were performed using a 1 m cable. Longer cables yield a lower level of

power, but the difference is negligible for cables of 2 m or less in length.

* Subtract 0.08 W for the SC-2350 carrier due to its TEDS circuitry.

Nominal Ripple and Noise
Voltage Level | Efficiency Line Regulation Load Regulation (DC to 10 MHz)
+5 VDC 100% System-dependent System-dependent System-dependent
+15 VDC 62% +0.5% typ +0.1% typ 15 mV s typ
-15 VDC 62% +0.5% typ +0.1% typ 20 mV ¢ typ
5C-2345/2350 Carrier User Manual A-12 ni.com



Appendix A Specifications

Physical

Screw-terminal wiring diameter

(J1 CONNECLOr) ..veiiiieiieieeeeeiieeeeeeeieeeee 24 t0 16 AWG

SCC-PWR02

PS01 Power Supply

AC input voltage ......cccceevevveeveneeseeneenne. 100 to 240 VAC

AC input frequency.......cccceveerveeneennnen. 47 to 63 Hz

AC input current (steady state) .............. 1.0 A max

In-rush current (at cold start) ................. 30 A max

Max OULPUL ...eveeeieeiieieeieeiee e 45 W

Efficiency ......cccceveevenieiiniecccee, 65% typ

Switching frequency .........coceeeeeveenennene 50 kHz nominal

Measurement Category .........cceceeerueennnenn 1I

Output (SCC-PWR02 Module)

Maximum OutputNoise
Power Line Load (DC to
Voltage Range Available | Regulation | Regulation 10 MHz)

+5 VDC (+4.64 to +5.25 VDC) 6.97 W* +1% +9% 20 mV 6 typ
+15 VDC (+14.45 to +15.25 VDC) 437TW +5% +10% 20 mV e typ
—15 VDC (-14.45 to —15.25 VDC) 437TW +5% +10% 20 mV 6 typ
* Subtract 0.08 W for the SC-2350 carrier due to its TEDS circuitry.

Other Features (PS01)

Short-circuit protection .............ceeeerueene Yes

Overvoltage protection...........c..ccceeueeee. 343 VAC (130%)
Dimensions of the external supply......... 15.5cm x 8.5 cm X 4.8 cm

(6.1in. x3.31in. X 1.91n.)
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Appendix A Specifications
Environment for External Supply
Operating temperature ..........cc.cceceevverneene 0to 40 °C
Storage temperature..............cceeeeecuennnes —20to0 80 °C
Relative humidity .......ccccovervevvecveneecennnne. 10 to 90%, noncondensing
Maximum altitude...........oooovvvvveieiinnnnnns 2,000 m
Pollution Degree (indoor use only) ........ 2
SCC-PWR03
Input
DC input voltage......ccoveevveereeenierrieenieens 7t042 VDC
Reverse-voltage protection..................... —42 VDC max
POWET ..o 325 mA at 12 VDC
Output
Maximum OutputNoise
Power Line Load (DCto
Voltage Range Available | Regulation | Regulation 10 MHz)
+5 VDC (+4.36 to +5.25 VDC) 6.55 W* +1% +12% 20 mV 6 typ
+15 VDC (+14.25 to +15.75 VDC) 0.87 W +5% +10% 20 mV 6 typ
—15 VDC (-14.45 to —-15.75 VDC) 0.87 W +5% +10% 20 mV 6 typ
* Subtract 0.08 W for the SC-2350 carrier due to its TEDS circuitry.
Physical
Screw-terminal wiring diameter
(J1 connector on module) ....................... 24 to 16 AWG
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Carrier Socket Signal
Assignments

This appendix contains descriptions of all the signals carried by the 20-pin
sockets on the SC-2345/2350 carrier. The pins are laid out on SCC modules
as shown in Figure B-1. For more information about the SC-2345/2350
carrier connector locations, refer to the SCC Quick Start Guide.
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1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin20

Figure B-1. SCC Module Bottom View
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Appendix B Carrier Socket Signal Assignments

SC-2345 Carrier

Table B-1. SC-2345 Carrier—Sockets J1-J16

J9-J16: Digital I/O or J1-J8: Single- or
Pin Number Single-Stage Analog Input Dual-Stage Analog Input
1 Al (X)+ to second stage Al (X) to DAQ device
2 Al (X)- to second stage —
3 AI SENSE AI SENSE
4 AT (X+8)+ to second stage Al (X+8) to DAQ device
5 AI SENSE —
6 AI GND AI GND
7 P0.(X) PFI 7/A1 SAMP CLK
8 Al (X+8)- to second stage —
9 +5V +5V
10 GND GND
11 A GND A GND
12 REF5V REF5V
13 +15V +15V
14 -15V -15V
15 — AI SENSE
16 To second stage To first stage
17 — Al (X)— from first stage
18 — Al (X+8)+ from first stage
19 — Al (X)+ from first stage
20 — Al (X+8)— from first stage

SC-2345/2350 Carrier User Manual B-2

ni.com



Appendix B Carrier Socket Signal Assignments

Table B-2. SC-2345 Carrier—Sockets J17-J18

Pin Number J17-J18: Analog Output DACO0 J17-J18: Analog Output DAC1
1 AO0 AO 1
2 AO GND AO GND
3 AO 1 AO O
4 AO GND AO GND
5 APFI 0/AO EXT REF APFI 0/AO EXT REF
6 PFI 5/A0 SAMP CLK PFI 5/AO0 SAMP CLK
7 — —
8 PFI 6/AO START TRIG PFI 6/AO START TRIG
9 +5V +5V
10 GND GND
11 A GND A GND
12 REF5V REF5V
13 +15V +15V
14 -15V -15V
15 — —
16 — _
17 — —
18 — —
19 — —
20 — —
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Appendix B Carrier Socket Signal Assignments
Table B-3. SC-2345 Carrier—Sockets J19-J20

Pin Number J19-J20: GPCTR 0 J19-J20: GPCTR 1
1 PFI 12/CTRO OUT PFI 13/CTR1 OUT
2 PFI 14/FREQ OUT PFI 14/FREQ OUT
3 PFI 9/CTR 0 GATE PFI 4/ CTR 1 GATE
4 P0.6 P0.7
5 PFI 8/CTR 0 SOURCE PFI 3/CTR 1 SOURCE
6 — —
7 — —
8 _ —
9 +5V +5V
10 GND GND
11 A GND A GND
12 REF5V REF5V
13 +15V +15V
14 -15V -15V
15 — —
16 — —
17 — PFI 1/AI REF TRIG
18 PFI 5/AO SAMP CLK PFI 11/AT HOLD COMP
19 PFI 0/AI START TRIG PFI O/AI START TRIG
20 PFI 6/AO START TRIG PFI 10/EXTSTROBE
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Appendix B Carrier Socket Signal Assignments

SC-2350
Table B-4. SC-2350—Socket J1-J8

Pin Number J1-J8: Analog Input
1 Al (X) to DAQ device
2 —
3 AI SENSE
4 Al (X+8) to DAQ device
5 —
6 AI GND
7 PFI 7/A1 SAMP CLK
8 —
9 +5V
10 GND
11 A GND
12 REF5V
13 +15V
14 -15V
15 1-Wire (X+8)
16 1-Wire (X)
17 —
18 —
19 —
20 —
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Appendix B Carrier Socket Signal Assignments

Table B-5. SC-2350—Sockets J17-J18

Pin Number J17: Analog Output DAC0 J18: Analog Output DAC1
1 AO0 AO 1
2 AO GND AO GND
3 AO 1 AO O
4 AO GND AO GND
5 APFI 0/AO EXT REF APFI 0/AO EXT REF
6 PFI 5/A0 SAMP CLK PFI 5/AO0 SAMP CLK
7 — —
8 PFI 6/AO START TRIG PFI 6/AO START TRIG
9 +5V +5V
10 GND GND
11 A GND A GND
12 REF5V REF5V
13 +15V +15V
14 -15V -15Vv
15 1-Wire (AO 1) 1-Wire (AO 0)
16 1-Wire (AO 0) 1-Wire (AO 1)
17 — —
18 — —
19 — —
20 — —
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Appendix B Carrier Socket Signal Assignments

SC-2345/2350 Carrier

Table B-6. SC-2345/2350 Carrier—Socket J21

Pin Number Signal
1 A GND
2 A GND/AI GND
3 +15V
4 -15V
5 +5V
6 —
7 External +5 VDC
8 External chassis GND
9 External +5 VDC
10 External chassis GND
11 External +15 VDC
12 External common
13 External —15 VDC
14 External common
15 DAQ device +5 VDC
16 DAQ device GND
17 DAQ device +5 VDC
18 DAQ device GND
19 DAQ device +5 VDC
20 DAQ device GND
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Appendix B

Carrier Socket Signal Assignments

Table B-7. SC-2345/2350 Carrier—SCC-PWRO0X Module Pin Signal Assignments (Socket J21)

Nul:llllll)er PWRO1 Signal PWRO2 Signal PWRO03 Signal Signal Description

1 A GND A GND A GND Ground reference for
+15 V supply
2 AI GND AI GND AI GND Signal ground from E/M Series
DAQ device

3 +15 V out +15 V out +15 V out +15 V supply to all SCC modules
4 —15 V out —15V out —15 V out —15 V supply to all SCC modules
5 — External +5 V out — +5 V supply to all SCC modules
6 _ _ _ —
7 — External +5 VDC — From external supply
8 — — —
9 — External +5 VDC From external supply
10 — — — —
11 — External +15 VDC — From external supply
12 — External common DC — From external supply
13 — External -15 VDC — From external supply
14 — External common DC From external supply
15 DAQ device +5 V — From E/M Series DAQ device
16 DAQ device GND — — From E/M Series DAQ device
17 DAQ device +5 V — — From E/M Series DAQ device
18 DAQ device GND — — From E/M Series DAQ device
19 DAQ device +5 V — — From E/M Series DAQ device
20 DAQ device GND — From E/M Series DAQ device
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Appendix B

Carrier Socket Signal Assignments

Table B-8. SC-2350 TEDS Test Header Pin Signal Assignments (Socket J35)

Connector
Diagram Signal Name Pin Number Pin Number Signal Name
AI TEDS CHDATA (0) 1 2 AI TEDS CHRTN (0)
; i AI TEDS CHDATA (8) 3 4 AI TEDS CHRTN (8)
5| 6 AI TEDS CHDATA (1) 5 6 AI TEDS CHRTN (1)
718 AI TEDS CHDATA (9) 7 8 AI TEDS CHRTN (9)
191 :Z AI TEDS CHDATA (2) 9 10 AI TEDS CHRTN (2)
13|14 AI TEDS CHDATA (10) 11 12 AI TEDS CHRTN (10)
:? 1: AI TEDS CHDATA (3) 13 14 AI TEDS CHRTN (3)
19 | 20 AI TEDS CHDATA (11) 15 16 AITEDS CHRTN (11)
21|22 AI'TEDS CHDATA (4) 17 18 AITEDS CHRTN (4)
22 22 AI TEDS CHDATA (12) 19 20 AI TEDS CHRTN (12)
27|28 AI TEDS CHDATA (5) 21 22 AI TEDS CHRTN (5)
2? 2(2) AI TEDS CHDATA (13) 23 24 AI TEDS CHRTN (13)
33|34 AI TEDS CHDATA (6) 25 26 AI TEDS CHRTN (6)
gi g: AI TEDS CHDATA (14) 27 28 AI TEDS CHRTN (14)
39 |40 AI TEDS CHDATA (7) 29 30 AI TEDS CHRTN (7)
41]42 Al TEDS CHDATA (15) 31 32 AI'TEDS CHRTN (15)
:g :z AO TEDS CHDATA (0) 33 34 AO TEDS CHRTN (0)
47 | 48 AO TEDS CHDATA (1) 35 36 AO TEDS CHRTN (1)
4950 NC 37 38 NC
NC 39 40 NC
NC 41 42 NC
NC 43 44 NC
NC 45 46 NC
NC 47 48 NC
NC =No NC 49 50 NC
Connect
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SCC Power Requirements
and Solutions

Installing new SCC modules in the SC-2345/2350 carrier increases the
power requirements of the SCC system. Depending on the number and
types of modules you are using, the power requirements of an SCC system
can eventually exceed the amount of power available from the SCC-PWR
module. Copy the following worksheets and use them to recalculate the
power requirements of the SCC system when you add new SCC modules.
To calculate